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1. Introduction 
1.1 What is GeneQuick? 

GeneQuick is a desktop application designed for molecular biology research using DNA sequences 
and plasmids. It allows users to carry out essential tasks in a single integrated environment, including 
viewing and editing sequences, visualizing plasmid maps, analyzing restriction enzymes, performing 
sequence alignment, analyzing chromatogram (AB1) data, and designing primers. 

 

Figure 1-1. Overview of GeneQuick 

GeneQuick supports major file formats such as .gb, .fasta, .seq, .ape, .dna, and .ab1, allowing users 
to import existing data directly and use it for analysis without additional conversion. 

This software is designed not only for use in research laboratories, but also as a personal tool that 
individual researchers and students can easily use on their own computers. This allows users to carry 
out sequence analysis and design work efficiently, regardless of location or working environment. 

In addition, GeneQuick supports multiple languages, including English, Japanese, Chinese 
(Simplified and Traditional), Korean, German, French, Spanish, and Italian, providing a 
multilingual environment accessible to researchers around the world. 
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GeneQuick offers a 14-day free trial from the first launch, during which all features are available at 
no cost. After the trial period ends, users can continue using the software indefinitely by purchasing a 
license. 

 

1.2 Key Features 

• Perform sequence editing and analysis in one integrated software application  
• Intuitive visualization of plasmid maps  
• Fast and detailed viewing of AB1 chromatograms  
• Sequence comparison with high-speed alignment  
• Built-in primer design tools  
• Personal-use design suitable for individual researchers and students  
• High compatibility with major file formats  
• Multilingual support for users around the world  
• 14-day free trial and a perpetual license available through one-time purchase  

 

1.3 System Requirements 

GeneQuick can be used in the following environment. 

Supported Operating Systems 
Mac: Apple Silicon Macs (M1 or later), macOS Sonoma or later 
Windows: Windows 11 or later 

Supported operating system versions may change in future updates. 

Recommended Environment 
Memory: 8 GB or more 
Storage: At least 500 MB of free space 
Internet connection: Required only for license activation (normal use is available offline) 

GeneQuick is designed as a desktop application that runs comfortably not only on shared computers 
in laboratories, but also on personal laptops used by individual researchers and students. 
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2. Installation and Initial Setup 

2.1 Installation 

Download the version of GeneQuick that matches your computer environment from the GeneQuick 
introduction webpage (https://gene-quick.com/index.html). 

For Mac 
Open the .dmg file, then drag and drop the application icon into the Applications folder. 

For Windows 
Open the .exe file and follow the on-screen instructions to complete the installation. 

[Installing the Windows Version] 

During installation, you may see a message from Microsoft Defender SmartScreen stating, 
"Windows protected your PC." This message does not necessarily mean that the application is 
unsafe. It may appear for new applications that do not yet have a sufficient reputation on Windows. 

If this warning appears, you can proceed as follows: 

1. Click "More info". 

2. Click "Run anyway". 

3. Then follow the on-screen instructions to continue the installation. 

 

2.2 First Launch 

2.2.1 For Mac 

When launching GeneQuick for the first time, the application may not open from Launchpad or other 
standard shortcuts. 

In that case, open Finder and select: Go → Applications 

Then select the GeneQuick application, Control-click it (or right-click it), and choose Open. 

An alert message may appear, but please click “Open” to proceed. 

After the first launch, GeneQuick can be opened normally from Launchpad and other standard 
shortcuts. 

https://gene-quick.com/index.html
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2.2.2 For Windows 

Click the GeneQuick icon created after installation to open the application.  
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3. License and Usage 

3.1 Free Trial 

When you launch GeneQuick for the first time, a 14-day free trial will begin automatically. 

Please note that an internet connection is required during the free trial period. After purchasing a 
license, GeneQuick can be used offline. 

After the 14-day trial period ends, the use of the application will be restricted. We therefore recommend 
purchasing a license before the trial expires. 

 

Figure 3-1. Screen displayed during the free trial period 

3.2 How to Purchase a License 

To purchase a license, click the Buy button displayed in the lower-right corner of the application, or 
visit the purchase page available on the GeneQuick introduction website (https://gene-
quick.com/index.html). 

On the purchase page, please enter the required information, such as your institution, name, and 
email address, and complete the payment process. 

After the purchase is completed, a license key will be sent to your registered email address. 

https://gene-quick.com/index.html
https://gene-quick.com/index.html
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3.3 License Activation 

To activate your license, click the Activate button in 
the lower-right corner of the screen, or open the 
Settings menu in the menu bar and select Activate. 

Enter your email address and the license key 
provided in the email you received after purchase, 
and then click the Activate button. 

If the activation is successful, the free trial display in the lower-right corner of the screen will 
disappear, and GeneQuick will become available as a licensed version. 

 

3.4 License Deactivation and Management 

With a standard license, GeneQuick can be used on up to two PCs. 
With a student license, GeneQuick can be used on one PC only. 

The software cannot be used on more devices than the number allowed by your license. 

If you would like to move your license to another PC, you must first deactivate the license on the PC 
currently in use. 

To deactivate the license, open the Settings menu from the menu bar and select Deactivation (This 
PC). 

A confirmation dialog will appear. Click OK to complete the deactivation. 

If you are unable to deactivate the license on your old PC due to hardware failure or another issue, 
please contact us and provide your institution, name, and email address. 
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4. Screen Layout 

4.1 Menu Bar 

The GeneQuick menu bar consists of the following menus: GeneQuick, File, View, Sequence, 
Settings, and Language. 

Figure 4-1. Menu bar 

4.1.1 “GeneQuick” Menu 

GeneQuick: Displays application version information. 
Hide GeneQuick: Hides the GeneQuick window. 
Hide Others: Hides all running applications except GeneQuick. 
Show All: Shows all running applications that are currently hidden. 
Quit GeneQuick: Closes the GeneQuick application. 

4.1.2 The “File” Menu 

New: Creates a new file. 
Open: Opens an existing file. 
Save: Saves the current file. 
Save As: Saves the file with a specified file format and file name. 
Print: Prints the current file. 
Export: Exports the file in GenBank (.gb), FASTA (.fa), or Sequence (.seq) format. 

4.1.3 The “View” Menu 

Map: Displays the map view of the sequence. 
Sequence: Displays the nucleotide sequence. 
Show Features: Displays the list of features. 
Show Primers: Displays the list of primers. 
Show Enzymes: Displays the list of restriction enzymes. 
Enter Full Screen: Switches the display to full-screen mode. Press Esc on the keyboard to return to 
the normal view. 
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4.1.4 The “Sequence” Menu 

Show Sequence: Switches to the sequence view. 
Show Alignment: Switches to the analysis view. 
Find: Displays a search box at the bottom of the screen. 
Go to Position: Moves the cursor to a specified position in the sequence view. 
Go to Top: Moves to the beginning of the sequence view. 

4.1.5 The “Settings” Menu 

Activate: Activates the license. See Section 3.3. 
Deactivate: Deactivates the license. See Section 3.4. 

4.1.6 The “Language” Menu 

You can select the display language from English, Japanese, Chinese (Simplified), Chinese 
(Traditional), Korean, German, French, Spanish, and Italian. 

 

4.2 Common Screen Buttons 

4.2.1 Top of the Screen (First Row) 

The first row at the top of the screen contains the following buttons: New, Open, Save, Save As, and 
Print. 

Files that are currently open are also displayed in this row as tabs. 

 

Figure 4-2. Common screen buttons 

 

4.2.2 Top of the Screen (Second Row) 

The second row at the top of the screen contains the following buttons: Map, Sequence, Enzyme, 
Feature, Primer, and Analysis. 
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The file name is displayed on the left side. 

Clicking the DNA button on the right side allows you to switch between DNA and RNA mode. 
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5. Basic Operations 

5.1 Opening Files 

5.1.1 Creating a New File 

To create a new file, select New from the File menu in the menu bar, or click the New button at the 
top of the screen. 

5.1.2 Opening an Existing File 

To open an existing file, select Open from the File menu in the menu bar, or click the Open button at 
the top of the screen. Then, move to the folder containing the file you want to open and select the file. 

In addition to .geneq files, GeneQuick supports .gb, .fasta, .seq, .dna, and .ab1 files. 

Files can also be opened by drag and drop. When you drag a file onto the GeneQuick window, the 
message “Drop a file to open” will appear. Drop the file onto this area to open it. 

 

5.2 Saving Files 

To save a file, select Save from the File menu in the menu bar, or click the Save or Save As button at 
the top of the screen. 

5.2.1 GeneQuick Format (.geneq) 

We recommend saving files in the native GeneQuick format (.geneq). 

Once a file has been saved in this format, it can be overwritten directly the next time by using Save. 

In addition to sequence data, the .geneq format can store features, primer information, and alignment 
data used in analysis, including alignments with Sanger sequencing data. 

GeneQuick can also save files in GenBank (.gb, .gbk), FASTA (.fasta, .fa), and Sequence (.seq) 
formats. 

5.2.2 GenBank Format (.gb, .gbk) 

In GenBank format, feature and primer information can be saved, but alignment data, including 
alignments with Sanger sequencing data, cannot be saved. 
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If you want to open the file in other software such as ApE or SnapGene, please save it in GenBank 
format. 

5.2.3 FASTA Format (.fa, .fasta) and Sequence Format (.seq) 

In FASTA (.fa, .fasta) and Sequence (.seq) formats, feature and primer information are not saved. 
Only the nucleotide sequence itself is stored. 
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6. How to Use the Sequence View 

In the Sequence view, you can display and edit nucleotide sequences, as well as add and edit features 
and create and edit primers. However, .ab1 files cannot be edited in the Sequence view. For editing 
.ab1 files, please refer to Section 12. How to Use the Analysis View. 

 

Figure 6-1. Sequence view 
 

6.1 Viewing and Editing Nucleotide Sequences 

When a file is opened, the nucleotide sequence is displayed in the Sequence view. To edit the 
sequence, move the cursor to the desired position. 

To select multiple bases, click and drag across the sequence. You can also select multiple bases by 
holding down the Shift key while using the arrow keys on the keyboard. 

6.1.1 Copying Bases 

Select the nucleotide sequence you want to copy, then use Copy (Command + C) or click the Copy 
button in the third row at the top of the screen. 
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6.1.2 Cutting Bases 

Select the nucleotide sequence you want to cut, then use Cut (Command + X) or click the Cut button 
in the third row at the top of the screen. 

6.1.3 Inserting Bases 

Move the cursor to the desired position and type A, G, C, T, or U. 

If you have copied a sequence, move the cursor to the desired position and use Paste (Command + 
V) or click the Paste button in the third row at the top of the screen. 

6.1.4 Deleting Bases 

Press the Backspace key to delete the base immediately before the cursor. Press the Delete key to 
delete the base immediately after the cursor. 

To delete multiple bases at once, select the desired region and then press Backspace or Delete. 
Multiple bases can be selected either by clicking and dragging across the sequence or by holding down 
the Shift key while using the arrow keys. 

You can also delete selected bases by clicking the Delete button in the third row at the top of the 
screen. 

6.1.5 Replacing Bases 

Select the region you want to replace, then paste the previously copied nucleotide sequence by using 
Paste (Command + V). 

6.1.6 Reverse Complementing a Sequence 

To convert a nucleotide sequence into its reverse complement, select the region you want to change 
and click the RevComp button in the third row at the top of the screen. 

If no sequence is selected, the entire file will be converted into the reverse complement sequence. 

6.1.7 Undo and Redo 

To undo an edit, click the Undo button in the third row at the top of the screen. To redo an action, click 
the Redo button. 

Please note that Undo and Redo have limitations, so we recommend saving your sequence regularly. 
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6.1.8 Switching Between DNA and RNA Mode 

By default, GeneQuick is set to DNA mode. If your sequence is RNA, or if you want to convert a DNA 
sequence to RNA display mode, click the DNA button on the right side of the second row at the top of 
the screen. 

The label will change to RNA, indicating that RNA mode is active. Click the RNA button again to 
return to DNA mode. 

6.1.9 Selecting Features, Primers, and Amino Acid Sequences 

Clicking a feature or primer track selects the corresponding nucleotide sequence, allowing it to be 
copied, cut, or deleted. 

In addition, if you select amino acid residues within a CDS and right-click, the following options will 
appear: 

• Copy amino acid sequence for selection  

• Copy amino acid sequence for entire CDS  

Selecting either option will copy the amino acid sequence. 

 

6.2 Adding and Editing Features 

Features can be displayed on the nucleotide sequence. If you open a file from GenBank, Addgene, or 
another source in which feature regions have already been defined, those features will be displayed 
automatically. 

6.2.1 Adding a Feature 

Select the region of the nucleotide sequence where you want to add a feature. With the region selected, 
click the + Feature button in the third row at the top of the screen. The Add Feature window will 
open. 

In the Add Feature window, enter the following information: 

Feature name: Enter the name of the feature. 
Type: Select the feature type, such as CDS, gene, or promoter. If CDS is selected, the translated 
amino acid sequence will be displayed on the nucleotide sequence. 
Start and End: The start and end positions of the selected region are displayed automatically. If 
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necessary, you can change these positions manually. 
Color: Select the label color for the feature. By default, colors are assigned according to feature type. 
Note: Enter any notes if needed. 

After entering the required information, click OK to register the feature. 

If you click Cancel or the × button, the feature will not be added and the Add Feature window will 
close. 

6.2.2 Editing a Feature 

To edit a feature, click the feature track. Then right-click and select Edit Feature. Alternatively, you 
can click the Feature Edit button in the third row at the top of the screen to open the editing window. 

Make the necessary changes in the Edit Feature window, then click OK. 

6.2.3 Deleting a Feature 

To delete a feature, click the feature track and then right-click. Select Delete Feature from the menu. 
A confirmation dialog will appear. Click Delete to complete the deletion. 

Alternatively, after selecting the feature track, you can click the Feature Delete button in the third row 
at the top of the screen. 

 

6.3 Adding and Editing Primers 

Primers can also be displayed on the nucleotide sequence. 

6.3.1 Adding a New Primer 

Select the region for which you want to design a primer, then click the + Primer button in the third 
row at the top of the screen. The Primer Designer window will open. 

For details on how to use the Primer Designer, please refer to Section 11. 

6.3.2 Editing a Primer 

To edit a primer, click the primer track. Then right-click and select Edit Primer. Alternatively, you 
can click the Primer Edit button in the third row at the top of the screen to open the editing window. 

Make the necessary changes in the Primer Designer window, then click Update. 
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6.3.3 Deleting a Primer 

To delete a primer, click the primer track and then right-click. Select Delete Primer from the menu. 
A confirmation dialog will appear. Click Delete to complete the deletion. 

Alternatively, after selecting the primer track, you can click the Primer Delete button in the third row 
at the top of the screen. 
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7. How to Use the Map View 

In the Map view, you can check the positions of nucleotide sequences, features, and restriction enzyme 
sites. You can also select a region on the map and jump to the corresponding sequence in the Sequence 
view. 

 

Figure 7-1. Map view 

 

7.1 Displaying the Map 

With a sequence file open, click Map in the second row at the top of the screen. The map will be 
displayed based on the nucleotide sequence, features, and restriction enzyme sites. 

The displayed restriction enzyme sites are based on the enzymes selected in the Enzyme view. 

In the upper-left corner of the screen, Template length and Features are shown. 

When you place the mouse cursor over a feature, the position and direction of that feature are displayed 
in the upper-right corner. 
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7.2 Selecting Circular or Linear View 

By default, the map is displayed automatically as either Circular or Linear, depending on the file 
information. 

If you want to change the display format, click the Circular or Linear button in the upper-right corner 
of the screen. 

 

7.3 Selecting and Clearing Regions 

You can select specific regions directly on the map. 

When you click a feature track, sel (selected position and length) and Selected (the name of the selected 
feature) are displayed in the upper-left corner of the screen. 

If you double-click a feature track, GeneQuick will switch to the Sequence view and jump to the 
nucleotide sequence of the selected feature. 

You can also double-click a restriction enzyme site to move to the Sequence view and jump to the 
nucleotide sequence at that restriction site. 

In addition, if you click one restriction enzyme site and then Shift-click another restriction enzyme 
site, the sequence between the two sites will be selected and shown as a yellow region. 

If you double-click the selected yellow region, GeneQuick will switch to the Sequence view and jump 
to that selected region. 

To clear the selected region, click Clear selection in the lower-left corner of the screen. 
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8. How to Use the Enzyme View 

In the Enzyme view, information about restriction enzyme sites in the nucleotide sequence is 
displayed. You can also change which restriction enzymes are shown. 

 

Figure 8-1. Enzyme view 

 

8.1 Displaying Restriction Enzymes 

With a sequence file open, click Enzyme in the second row at the top of the screen. A list of restriction 
enzyme sites in the nucleotide sequence will be displayed. 

In the list, you can check the following information: Enzyme (enzyme name), Sites (number of sites), 
Position, Recognition Site, and Overhang. 

By default, the list includes commonly used restriction enzymes. 

Among them, restriction enzyme sites that are unique within the nucleotide sequence, meaning they 
appear only once, are checked and displayed in the Sequence view and the Map view. 
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You can turn the display of each enzyme on or off by checking or unchecking the box on the left side 
of the enzyme list. 

 

8.2 Searching for and Adding Restriction Enzymes 

In the Enzyme view, you can search for a restriction enzyme by entering its name in the search box 
above the enzyme list. Matching enzymes will then be displayed. 

If you find an enzyme you want to add, click Add on the right side. 

If an enzyme has already been added to the list, it will be marked as Added. 

For enzymes that have already been added, check Show if you want them to be displayed in the 
Sequence view or the Map view. 

To close the search box, click the Clear button on the right side of the search field. 

To remove an added enzyme, click the – symbol shown next to the enzyme name in the list. 

 

8.3 Jumping to a Restriction Enzyme Site 

If you click a number in the Position column of the restriction enzyme list, GeneQuick will switch to 
the Sequence view and jump to the corresponding restriction enzyme site. 
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9. How to Use the Feature View 

In the Feature view, information about features in the nucleotide sequence is displayed. You can also 
edit or delete existing features. 

 

Figure 9-1. Feature view 

 

9.1 Displaying Features 

With a sequence file open, click Feature in the second row at the top of the screen. A list of features 
in the nucleotide sequence will be displayed. 

In the list, you can check the following information: Feature (feature name), Position, Size, Color, 
Direction, and Type. 

 

9.2 Searching for Features 

You can search for features in the list by entering a keyword in the search box. 
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9.3 Editing and Deleting Features 

To edit a feature, double-click the feature in the list. The Edit Feature window will open. 

After making your changes, click OK to save them. To cancel and return without saving, click Cancel 
or the × button. 

To delete a feature, click the Delete button on the right side of the feature in the list. A confirmation 
dialog will appear. Confirm the deletion to remove the feature. 

 

9.4 Jumping to a Feature 

If you single-click a feature in the list, its background will be highlighted in blue. 

When you then move to the Sequence view, GeneQuick will jump to and display the nucleotide 
sequence corresponding to the selected feature. 
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10. How to Use the Primer View 

In the Primer view, information about primers in the nucleotide sequence is displayed. You can also 
edit or delete existing primers. 

 

Figure 10-1. Primer view 

 

10.1 Displaying Primers 

With a sequence file open, click Primer in the second row at the top of the screen. A list of primers in 
the nucleotide sequence will be displayed. 

In the list, you can check the following information: Name, Pos (position), Length, Tm (anneal), 
Strand, and Sequence. 

 

10.2 Editing and Deleting Primers 

To edit a primer, click the Edit button for the primer in the list. The Primer Designer window will 
open. 

After making your changes, click Update to apply them. 

To delete a primer, click the Delete button on the right side of the primer in the list. A confirmation 
dialog will appear. Confirm the deletion to remove the primer. 
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11. How to Use the Primer Designer 

The Primer Designer allows you to design multiple primers at the same time while comparing them 
side by side. 

You can add additional primer cards by clicking the + Primer button in the lower-left corner of the 
Primer Designer window. 

 

Figure 11-1. Primer Designer view 

 

11.1 Opening the Primer Designer 

To open the Primer Designer, go to the Sequence view and click + Primer in the third row at the top 
of the screen. 

If you select a nucleotide sequence before opening the Primer Designer, the selected sequence will be 
entered automatically when the window opens. 

To edit an existing primer from the Sequence view, click the primer track and then click Primer Edit. 

You can also open the Primer Designer from the Primer view by clicking Edit for the primer in the 
list. 
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11.2 Using the Primer Designer 

11.2.1 Entering Name, Adaptor, and Anneal 

When the Primer Designer window opens, first enter the Name, Adaptor, and Anneal fields. 

Name: Enter the name of the primer. 
Adaptor: Enter the sequence of the adaptor region. 
Anneal: Enter the sequence used for annealing. By default, the sequence selected in the Sequence 
view is entered automatically. 

When designing the Adaptor and Anneal sequences, refer to the Length, Tm, and GC% values 
shown in the upper-right corner, as well as the Template mini-view shown at the bottom of the 
window. 

11.2.2 Useful Functions for Primer Design 

Reverse Complement: 
If this option is checked, the sequence will be converted to its reverse complement. When this option 
is enabled, feature sequences and restriction enzyme sequences described below will also be entered 
in reverse-complement form. 

Feature Sequence: 
Commonly used sequences, such as Kozak sequences and protease recognition sequences, are 
available here. When selected, the sequence is automatically entered into the Adaptor field. 

Restriction Enzyme: 
If you select a restriction enzyme recognition sequence from the list, that sequence will be 
automatically entered into the Adaptor field. 

Copy to Anneal: 
Select any region from the sequence shown in the Template mini-view, then click Copy to Anneal 
to add the selected sequence to the Anneal field. 

11.2.3 Add, Copy, and Close 

After entering the Name, Adaptor, and Anneal fields, click Add to register the primer sequence. The 
primer will then also be displayed in the Sequence view. 
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Copy: 
Clicking Copy copies the full primer sequence (Adaptor + Anneal), which can then be pasted into 
another text file such as a Word document. 

Close: 
Clicking Close closes the current primer design window. Please note that any primer currently being 
designed will not be saved unless it has been added. 

11.2.4 Close All 

Click Close all to close the Primer Designer window. 
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12. How to Use the Analysis View 

The Analysis view is mainly used to align and compare template DNA with Sanger sequencing data 
such as .ab1 files. Based on the Sanger sequencing results, you can also edit the sequence. 

In addition to Sanger sequencing data (.ab1 files), the Analysis view also supports multiple file 
formats, including .seq, .fasta, .dna, and .gb, allowing you to compare sequences from different 
sources. 

 

Figure 12-1. Analysis view 

 

12.1 Opening the Analysis View 

With a sequence file open, click Analysis in the second row at the top of the screen. 

The nucleotide sequence will be displayed as the template sequence. 

 

12.2 Loading Sequence Files (.ab1 and Others) 

Click Load Read in the upper-left corner of the screen to select a file. 

Choose the sequence file you want to load, then click Open. The file will be loaded into the Analysis 
view. 
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Alternatively, you can drag and drop a sequence file onto the Load Read area. In this case, multiple 
files can also be loaded at the same time. 

 

12.3 Aligning Sequence Files 

When a sequence file such as an .ab1 file is loaded, it is automatically aligned to the template sequence. 

If the loaded file is an .ab1 file, you can display the chromatogram trace data by checking Chrom for 
each file shown on the left side of the screen. 

If a base in the loaded sequence differs from the template sequence, or if there is no corresponding 
base (gap), that position is shown with a red background. 

If a base is present in the loaded sequence but not in the template sequence, that position is shown with 
a blue background. 

 

12.4 Editing Sequences 

12.4.1 Editing the Template Sequence 

To edit the template sequence, move the cursor to the target position and insert, delete, or replace bases 
as needed. 

You can edit the sequence by selecting bases and using standard operations such as Copy (Command 
+ C), Paste (Command + V), and Delete (Delete or Backspace). 

When bases are inserted into or deleted from the template sequence, the alignment is automatically 
recalculated. 

12.4.2 Editing Sanger Sequencing Data 

Aligned sequence files can also be edited by selecting bases and using standard operations such as 
Copy (Command + C), Paste (Command + V), and Delete (Delete or Backspace). 

When trimming bases from the 5′ end or 3′ end, it is recommended to delete all bases up to the 
sequence end for a cleaner result. 
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Please note that editing a loaded sequence file does not automatically realign it to the template 
sequence. If realignment is needed, click the Realign button for the corresponding file on the left side 
of the screen. 

 

12.5 Notes on Analysis 

If you edit the template sequence in the Analysis view, those changes will also be reflected in the 
Sequence view. 

In contrast, edits made to loaded sequence files during analysis are not saved. These edits are intended 
only for checking and reviewing Sanger sequencing data. 

When you save the file in .geneq format, the loaded sequence files are saved together with the project. 
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13. Printing 

13.1 How to Print 

The following views can be printed: Map, Sequence, Enzyme, Feature, and Primer. 
The Analysis view cannot be printed. 

To print, open the view you want to print and click Print in the first row at the top of the screen. 

You can also print from the menu bar by selecting File → Print. 

 
 


